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1. Introduction

This manual, Possibilities with PowerPoint, is a production of the Educational Technology Component of
Expanding Educational Horizons. It provides examples of how Microsoft PowerPoint 2002 can be used to
present interactive, multimedia, instructional materials to enhance literacy and numeracy in the primary
curriculum. Sections 1-4 introduce you to possibilities with PowerPoint. The remaining sections provide
steps for using specific features in PowerPoint to create a PowerPoint instructional medium — an

interactive multimedia tutorial.

2. Objectives

After using the manual, you will be able to:
1. Describe ways in which PowerPoint can be used to design instructional materials to address
learning needs in primary curriculum
2. Design an interactive tutorial using Microsoft PowerPoint to improve literacy and numeracy by
making effective use of the following tasks:
(a) Prepare a storyboard for the interactive tutorial
(b) Start using Microsoft PowerPoint
(c) Design the master layout for all slides
(d) Change font colour and size
(e) Use AutoShapes to design slide layout
)] Insert Hyperlinks to websites and other documents
(9) Organize content for a tutorial
(h) Prepare a sound file
0] Insert a sound file into a PowerPoint presentation
()] Insert pictures into a PowerPoint presentation
(k) Custom animation for objects
0] Select and Apply appropriate Slide Transitions
(m)  Create interactive assessment tasks
(n)  Set up the tutorial presentation to be viewed as at a kiosk

(0) Save the presentation as a PowerPoint Show
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3. Possibilities with Presentation Software

Presentation software tools are used to create documents called presentations, which are used to
communicate ideas, summaries of information, demonstrations to a group. The presentation, which can
be viewed as slides (sometimes called a slide show) is usually displayed on a large monitor or on a

projection screen. Microsoft PowerPoint is an example of a presentation software package.

Because it is readily available and fairly easy to use, PowerPoint is usually the multimedia tool of choice
for classroom use. PowerPoint is a versatile tool and can be used to design a variety of multimedia
interactive learning materials to enhance students’ understanding of content. Table 1 below highlights

teacher-generated possibilities with PowerPoint.

Table 1 Teacher uses of PowerPoint

Instructional Uses Example

Support for Teachers can use presentations to focus student attention, maintain interest

presentation of content | and guide note-taking.

Practice Screens You can use practice screens to: help build vocabulary skills, reinforce math
concepts; practise parts of speech; practise spelling; reinforce story
problems; reinforce number/letter knowledge, or colors

Assessment and You can create multiple-choice items with appropriate feedback for each
Feedback Screens option. The items can be used to help learners track progress in specific

language skills and vocabulary sets.

Short Interactive A tutorial can be so designed with multimedia activities to help students learn
Tutorials new concepts in algebra and consumer arithmetic; and improve word

recognition, comprehension, and counting skills,

Web Quests A web quest is an inquiry-oriented activity designed to help students solve a
problem e.g. a web quest could be designed to help students find out which
planet is suitable for human life, or the web quest could focus on how to

prevent pollution in the community.

Picture Walk/Virtual This technology integration strategy provides students with the opportunity to

Field Trip see people and places they could not visit

Interactive Storybooks | Storybooks can be used to strengthen students’ language skills as they hear
the story being read aloud. Various objects in the story can be hyperlinked
so that when students click on the objects, they will hear audio or see
animation. A short quiz can be created at the end of the storybook. Students

can also create their storybooks.
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Table 1 cont'd

Instructional Uses Example

Digital Portfolios Teachers can document students’ learning using a camcorder or audio
recorder in powerful ways! For example, if both the teacher and student wish
to focus on improving the student’s fluency in reading skill, the teacher can
record the student reading aloud at various (or scheduled) times fortnightly.
It would be more authentic to get the student reading aloud in a group (e.g.
oral presentation) than simply reading to the teacher in private. These
recordings can be inserted in PowerPoint, dated and both the teacher and
the student can make their entries on each reading. After three readings, the
student and teacher can listen to these readings and discuss whether
improvement is taking place. Portfolios can be used to track a student’s
progress in other areas such as number and letter knowledge, auditory

perception, algebraic concepts, consumer arithmetic

Science Presentations | Teachers or students can use PowerPoint to teach processes and how
things work. They can add additional items to a diagram to illustrate how a

process grows and changes.

Table 2 Student uses of PowerPoint

Instructional Uses Example

Book reports Students can present their summary report (including audio and animated

objects) of a book they read using PowerPoint.

Field Trip Slide Shows Develop field trip slide shows to review and apply knowledge learned on a field
or Digital Story trip. Students can work together to make a slide show that presents what they

saw, as well as what they learned.

Autobiographical Students can create short autobiographical stories about themselves. Scanned
Stories photos can be inserted for interest. Once the slides have been created, you

can put them together in a presentation to show parents.

Poetry Readings Students can create slides exhibiting their personal poetry along with a voice

recording.

This manual focuses on one PowerPoint possibility: Interactive Tutorial. An interactive tutorial is an
instructional medium that offers comprehensive information on a given topic, including explanations,
examples, opportunities for practising skills, and provision of meaningful feedback on questions

answered.
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4. Instructional Design Process for Classroom Pract ice

A. ldentify problem

Before starting to design an instructional medium, consider this question: What specific needs or

problems do my students have that resources can help meet?

Activity 1

Examine Table 3 below. In your group, discuss what students would do or say if they had a problem in

the areas listed in column 1. Using Tables 1 and 2, as well as your experience in the classroom, suggest

a possible instructional medium to help address the problem.

Table 3

Problem Area

Evidence (How would student respond)

Instructional medium

1. Fluency

2. Word identification

skills

3. Comprehension

4. Counting

5. ldentification of

Shapes

6. Geometry

B. Analyse Learners

Study the instructional setting and try to formulate a paragraph describing your learners. The description

should at least address the learners’ age, socio-economic status, learning style, and needs as this would

help to clarify if any technology intervention e.g. an instructional medium is needed and if yes, what type.

Resource Teachers’ Workshop
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C. Formulate objectives

An objective is a statement of what the learner should be able to do after instruction or after using the
instructional medium. For example: “After reading the interactive story entitled “Cat and Rat”, students will

be able to pronounce words ending in —at with 100% accuracy”

D. Design the instructional medium

When you have identified the instructional medium, the next stage is to design it. During the design stage,
you will need to create a storyboard, which is a visual planning tool to help you organise what you will
want to appear on each slide (see Appendix A). You can use index cards or sticky paper to represent
information on each slide. This information should be a summary of content, pictures, audio, video or
animation effects. When designing the medium, keep the learning needs at the forefront of the design

process, as well as the literacy or numeracy strategy being used to address the difficulty.

E. Utilise the instructional medium

Teacher’s role

Clearly identify the teacher’s role in the implementation of the instructional medium. For example, does

the teacher need to be present and if yes, what should she do while the student uses the medium.

Students’ role

Describe how the student(s) will use the instructional medium - individually or in a group, as part of a
lesson or after the lesson. If the students will use it as part of the lesson, indicate when in the lesson and

possible questions and activities that a teacher could ask.

F. Evaluate

Include an assessment task for the learner and questions to be answered by both teachers and students
regarding the use of the technology in addressing the problem.

Planning is an essential activity when considering designing an instructional medium.

This manual will take you to Stage D of the Instructional Design Process, the Design Stage. After you
have designed the instructional medium, look for opportunities to incorporate the instructional medium in
your classroom practice and complete the design process by evaluating the medium. The next section of
this manual takes you through the procedures for using PowerPoint to design the instructional medium.

Resource Teachers’ Workshop 5
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5. Starting to use Microsoft PowerPoint

Before you start using Microsoft PowerPoint, create a folder in My Documents with the name of your

instructional medium.

Opening Microsoft PowerPoint
1. Go to the Task bar at the bottom of the screen.  |EIE=rEErHEr=s — [EET

~ | (A Desion Shiew Sice

. . . @] Ble Edt Vew Insert Format Tooks SideShow ﬂmduv; Hel
Point and click on Start button. Follow this DEHRE SRY (BB - T

=7 0 v

path: Start - Programs - Microsoft

PowerPoint

2. A blank slide, the Title slide, should appear. Glielctn add e

Insert the title of your instructional medium by clekto add subte

pointing and clicking in the text box “Click to
add title”. See Figure 1.
3. Inthe text box, “Click to add subtitle”, insert the

Click to add notes

mse ol
oo~ [ Aoshapes- \ 2 OB HE &-L-A-=S=206
Slide 10f 1

name(s) of the designers of the medium and

the date. Figure 1

Saving PowerPoint document

1. Save your PowerPoint presentation in your — i LE
folder. Select File - Save. You will notice that :
the file name is the same as your title. Click

Save. See Figure 2.

4. TechnologyIntegration.ppt

Timidy the Goat

Designed by: Melody Williams
August 2006

| Click to add notes

[Ee e | L\‘
i Autost

SN NOCE4 & B

Slide 1of 1

Figure 2

Inserting New Slides

1. Toinsert a new slide, go to the menu bar and select: Insert - New Slide (Figure 3). The Slide
Layout task pane appears. Point to the layout Title and Text, and then click it. This is slide 2. Insert
the following title for slide 2: Welcome or Introduction or Overview

2. Insert additional slides with the Title and Text layout to match the number of your subtopics.

Inserting a new slide (cont'd)

Resource Teachers’ Workshop 6
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3. For each additional slide, insert the subtopic in the [ B ]
Arial +18 v B I U E =E= Ay = A | Feson Dewside
text box: “Click to add title”. B P e e

x z | ¢ 4 slide Layout v =2
Apply shide layout:

‘ Click to add title | [t -
slides, insert another slide with the title: Are you 3 ~ -+ Click to add text

‘ L]
sure you want to quit? L | : i

5. Save your presentation. Note. To change the

4. After you have inserted the required number of

layout, go to Format in the menu bar and select | =[]

Content Layouts

e

Slide Layout .

Click to add notes

]

mE=e |
o I3 ] Aushapes~ N % ] O
Slide 20f2

B 2Wnd.. - ZiEHnen.,  E 2o

Figure 3

6.  Working in the Master Slide View — An Introducti  on

The slide master is a special feature of PowerPoint

that stores information about the slide template, | m— [BEE]
& i 0R & | Cose Master View
including font styles, placeholder sizes and POSIIONS, | g w v s oo o s & 7 PEI

DEHPR 8RY B o-o- O3 ZE -|E,
background design, and colour schemes. If you add a | * |

. . L Click to edit Master title style
picture, buttons, and shapes to the slide master, they :

i+ Click to edit Master text styles

will appear on all the slides in the presentation. ey

— Fourth level
» Fifth level

To access the Slide Master: Select
View > Master - Slide Master (see Figure 4).

[Ea=w |
o [b] Ausshepes~ N N O

7t [ w.
Working in the Master View saves you on the time that | rrmrrer—rs e

would be taken to make these changes to individual

Figure 4

slides.

When you have completed making adjustments to the
appearance of the slide template in the Slide Master
View, return to Normal View by selecting in the menu
bar View - Normal.

(o
Create a design for your slide template. You can adjust the font, font size, text box, background
colour. You can add menu buttons, shapes and pictures. Have fun!
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7.  Working with Font Options in the Master Slide Vi  ew

Changing the font colour and size

To change the font, colour and size of the text in the title text box, select the title text box and go to
Format - Font then choose the desired font, colour and font size. You could also change access the

font options on the Formatting toolbar (Figure 5).

Change
Font size

Close Master View _

A

sl -8 4B 7Ug EEE == =3 - [ Desian ji=New Slide Master
“E] He Edt Vew [nsert Format Tools SigeShow Window Help slide master 5
BRY -0 il O H

DEEHaH &V
=)

1

Third level
Fourth level
Fifth level

[Eez= 4| | :
D[awv Autoshapes~ N W OB 4l 2 H 3 - -# - A

Slide Master Default Design

Font colour

Figure 5

You can also change the font, colour and size of the text in the Object Area (see Figure 5).
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8.  Working with AutoShapes in the Master Slide View

Introduction to AutoShapes

The AutoShape menu on the drawing toolbar, allows you to access action buttons, block arrows, callouts
and basic shapes such as rounded rectangle, triangle, oval, octagon.
To insert an AutoShape:

|E';l- Basic Shapes » | 1. Select the AutoShape menu on the
Block Arrows b Y FRVES Drawing Toolbar (Figure 6) and
OO A DL
St d B QLT
ars an anners k
= OOl

Callouts 3 @ =

Flowchart b choose the shape you wish to use.
The cursor will turn to a plus sign (+).

2. Position the cursor where you want

B e § o

the shape to be inserted, click and

-

EE'EI' : | “| Action Evuttons [ 7, % O [l - - -
. Vﬂm = AN drag until the shape is the size you
B=n IEI [AutoShapes ~ | C 342 desire. Release the mouse.
slide Master 4

Yistat E W o B6 O

Figure 6

Working with AutoShapes

You may incorporate predefined shapes into your background to give your slides a unique look. How

many types of AutoShapes can you identify in the Figure 7 below?

Click to edit Master title style

Thle Area For Autolayouts

o o

/ e Click to edit Master text styles \
— Second level

o Third level

— Fourth level
» Fifth level

OO

D\ Object area For Aute \mﬂz

o

ki i ootery - E E Drawing
i Date frea | i Footer Area | [ her A
_ Tool Bar
OD=Eo=2 (|
Drawe [y G| auoshapes N W OO E 4@l & -S-A-==58 @
Siice Master Default Design o
Figure 7

You may add color, shadows and special effects to your AutoShapes by using the tools on the drawing

toolbar (see Figure 7).
Resource Teachers’ Workshop 9
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You can also change the shape by manipulating the yellow diamond icon (adjustment handle) on the
shape that is visible when the shape is selected.

TASK 1 Working with AutoShapes in the Master Slide View

A. Inserting Auto Shapes

In the Master Slide View, create a unique design for the background layout for your slides using
AutoShapes, Background Colour, and the Font dialog boxes.

B. Creating buttons for lesson titles

Using AutoShapes, create buttons for lesson titles. See Figures Figure 8 for an example of how the layout
of buttons could look. You may also use text for the lesson topics (Figure 9).

[€] Microsoft PowerPoint - [Simple machines.ppt] FEX) €] Microsoft PowerPoint - [Types of Teeth3.ppt] EEX)
avil -1 - B 7 US|[EE A A - (Fesan Dnewsice TmesNewRoman ~ 24 < | B Z U 3 | E[E|= A A A - | Hoeson Enewside _
DEdea kY (i i O B AA W % =| Bl DR SRY IR o- s 01 A A W 0% 2| @)=
Ble Edit View Insert Format Toos SideShow Window Help * ] Ble Edt Vew Insert Fomat Took SideShow Window Help x

A FEacEEDHIARD R, EFEacmEBAYHIARLR.

nl
a
x

x
= PRUTS

=] o T
i o™ F—
4 U
Home S ! Introducti Incisors brenclors  Molars
=
%I:l = This tur ut five fypes of feeth. Tt wil help you fo
 parts ard function of cach footh. You will
also the different types of teet]
After using this tutorial, you will e able 1o:
Click on one of the rames of the teeth o learn nane about .
H == :
= ~| |click to add notes E]
~| |Click to add notes =] .
= —— .
B TANOCEd IR 2-L-A-S=5846 .
o [ apshwes N \OOE A BE O-L-A-S=E586.
Side 3of 10 Default Design Englsh (U.5.) 22

Default Design Engish (U.) o
#,

[®ewwos. |diesintea. E2vcom. - &) W

Yistat €wSEGOS [® ewrwos... [ O eiintera. 2Maos... ~

Figure 8 Figure 9
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9 Working with Hyperlinks in the Master Slide View

9.1 Introduction to Hyperlinks

A hyperlink enables the user to navigate between locations by linking objects housed at different sections
of a document or housed in separate documents. You may add a hyperlink to your presentation and use it
to move to a variety of locations such as a specific slide within your presentation, a different presentation
altogether, a Microsoft Word document, a Microsoft Excel spreadsheet, or a web page. You can create a

hyperlink from any object, for example, text, basic shapes, action buttons and pictures.

Hyperlinks give the user the advantage to moving through a document in a non-linear fashion. Intensive

use of hyperlinks may be seen in websites and educational software such as tutorials.

9.2 Inserting a hyperlink

To insert a hyperlink:

1. Select the text, picture or shape you wish to hyperlink to another slide, web page or document.

2. Click on Insert on the menu bar.

3. Select Hyperlink and make the appropriate choice in the dialog box that appears (Figure 10).

4. To link to another slide within your PowerPoint presentation, select: Place in This Document and

choose the target slide that is the slide that you want to viewer to see when he clicks on the hyperlink.

Edit Hyperlink 3
Link to: Text to display: | =i = SreenTip..
@ Select a place in this document: slide preview:
Existing File or First Slide A
VebPeRE | Lastside
Mext Slide : .y
g Previous Slide
Place in This = Slide Titles
Document 1. Simple machines
2. Welcome
e} 3. Levers
Create New 4, Indined planes
Document 5. Pulleys i iz
L
& 5 r ; Remove Link

E-mail Address

OK | Cancel |

Figure 10

5. To link to a file such as a spreadsheet document, select Existing File or Web Page. Look for the
document by clicking the File button. Select the document, click OK. The name of the file should be
seen in the Insert Hyperlink dialog box. Click OK.

6. To link to a Web Page, select Existing File or Web Page. Type in the address of the web page.

Resource Teachers’ Workshop 11
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9.3 Inserting hyperlinks — Working with Action Butt

ons

An action button is an object that may be hyperlinked to enable the user to move from one location to

another in a document or between documents. Examples of action buttons are the Next and Previous

buttons. When hyperlinked, Next and Previous predefined buttons allow the user to move to the next

slide and the previous slide respectively.

le machines.ppt]

mat Tools [

ga Bl viewshow R i 54% 5 » - Closel
I U s Bekii Shows A A - [ Desion {=New Side Master _
Action Buttons » |
" ] [=]
il El ,
2, i Custom Animation... ster EIE[E stayle
4( i TiHa Araz'frr Autol avouts
[Z% Slide Transition... | Action Button: Forward or Next|
< ul
it Master text styles
— Second level
= Third level
— Fourth level
» Fifth level
e
Date Arep ! Object Area for AutoLayouts
B END |
Grade Four e Number Area
Figure 11
Action Settings
i Q
Mouse Click ‘ Mouse Over ] W © z
Action on dick
" Mone
¥ Hyperlink to:
|Mext Slide Bel
™ Run program:
In ‘ i
ol
173 e
[~ Play sound:
‘ _J b for AutoLayouts
W Highighecice T enp |
........ humber Area |
caces
14

Figure 12

To insert an action button:

1. Go to the menu bar and select

SlideShow -> Action Buttons .

Click on the desired action button (see
Figure 11).

Click on your slide and draw out the
shape of the action button. A dialog
box appears (Figure 12), which allows
you how to select the target location of
action button, for example Next Slide,
Previous Slide, Last Slide Viewed,
End Show.

Select the desired option and click on
OK. The hyperlink will now be active.
You can test the hyperlink in the Slide
Show View . By going to View -
Slide Show or by clicking screen icon
at the bottom left corner of the

PowerPoint window.

Placing navigation action buttons on the Slide Master allows the learner access to these buttons on all

slides.

Resource Teachers’ Workshop
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9.4 Changing the Colour of a Text Hyperlink

If you select text and insert a hyperlink to a location, you may notice that the text changes colour

automatically. To change the colour of hyperlinked text:

a > DD PE

Select the Custom tab.

Change the colour

Select Apply .

9.5 Adding Screen Tips

Additional information on an object such as a shape,

text or picture may be given using screen tips. Pointing

to a particular shape, text, or picture on a slide will

activate the screen tip which looks like text in a small

box (Figure 13a).

To add a screen tip:

1. Highlight the text that you want to hyperlink.
2. Select Insert = Hyperlink (Figure 13b).
3. Select Screen Tip. The Screen Tip dialog box below appears.

insert nyperiind

On the Format menu, select Slide Design followed by Slide Colour Scheme .

Under Scheme colours, select Accent and hyperlink and then select Change Colour .

OCE4l < @[

L

Figure 13a

2

Link to:

i
Existing File or
Web Page

Plaice in This
Document

Create New
Document

E-mail .;!'.ddress

Text to display: iIntroduction

Select a place in this document:

Slide preview:

ScreenTip. .. |

[=1- Slide Titles

-1, Slide 1
-2, Little Food
-3, Infroduction
-4, Canines
-5, Incisors
-6, Premalars
“ 7. Molars
-~ 8. Question 1
-9, Feedback A
~10, Feedback B

Pl

Set Hyperlink ScreenTip
Saeenlip text:

JCIick here to read what this tutorial is about,|

MNote: Custom ScreenTips are supported in Microsoft
Internet Explarer version 4.0 or ater,

oK | Cancel J
oK ] Cancel I

4. Type in the text to be displayed when the learner points on the text and click OK.

Figure 13b

5. Click OK to exit the Insert Hyperlink dialog box.

Resource Teachers’ Workshop
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9.6 Removing a hyperlink

To remove a hyperlink, select the object, text or button from which you want to remove the hyperlink.
1. SelectInsert in the menu bar.
2. Select Hyperlink .
3. Select Remove Link .

Task 2 Working with Hyperlinks in the Master Slide View

A. Insert hyperlinks to lesson slides
In the Master Slide view:
(

(ii) Insert a hyperlink to Lesson 1 slide.

) Select the shape or button with the Lesson 1 title.

(i) Select Lesson 2 shape/button and insert hyperlink to Lesson 2 slide.

(iv) Repeat the procedure for Lesson 3 shape/button.

B. Insert action buttons

Draw the following action buttons in appropriate positions on the slide: Next, Previous, Last Slide
Viewed, Quit.

See Figures 7-9 for examples. Note: For the QUIT button, you will need to select the Custom action
button and add the text QUIT.

Hyperlink Next button | TO next slide

Hyperlink Previous Button 4| TO previous slide
Hyperlink the Return Button EI TO last slide viewed.

IT
Hyperlink the Quit Button LI TO the slide entitled “Are you sure you want to quit?”

Resource Teachers’ Workshop
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C. Inserting hyperlinks to a file or website

0] Browse the Internet to find a website that could be used to support the learning of the content in
the tutorial.
(ii) Copy the address of the web site.
(i) Select text or an object to be linked to the website from the tutorial slide.

(iv) Insert the hyperlink to the website.

D. Using Screen Tips

()  Working in the Master Slide View, add screen tips to each lesson topic. The screen tip should
explain in a sentence the purpose of the lesson.
(ii) On the slide you inserted the hyperlink to the website, insert a screen tip on the text to

summarise the content of the website.

10. Organizing the Content

Once you have made adjustments to the Slide Master, you are now ready to add content to the slides of
your tutorial. Close the Slide Master View to return to Normal View and add the content.

9

.

Tips: For adding content, consider putting your welcome message and purpose of the tutorial on the
Introduction slide as the first step in adding content. For the beginning slide of each lesson, add the
learning objectives. Note: The lesson buttons must be hyperlinked to the beginning slide of each lesson.
Continue adding new slides if you need to add more content. When you have completed adding all the
content, identify slides that would be greatly enhanced with sound and pictures. Read the section on

inserting sound and inserting pictures to get information on how to do these tasks.

Resource Teachers’ Workshop 15
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11 Preparing and Inserting a Sound File

One method of enhancing the content in your presentation is by adding sound. This may be achieved by
selecting sound files from predefined galleries in ClipArt provided with PowerPoint, or by incorporating
your own recorded material. Sound may be used effectively in your presentation to explain diagrams or

complex processes such as “Water Cycle”.

11.1 Preparing an audio clip external to PowerPoint

E|E|@ 1. Prepare the script of the audio clip
— beforehand.

" Sound - Sound Recorder
File Edik Effects Help

Position: _ Length: . . .
000 sec. _ 0,00 sec. in the line- in jack of the computer.

| 3. Onthe task bar (Figure 14), select Start

2. Place the audio cable of the microphone

- _ _ - Programs -> Accessories >

Entertainment - Sound Recorder .

4. Select the red button to record and the

Click here to i black rectangular button to stop
[stop recording Click here to '
record recording.

Figure 14 5. Save your file in your folder.

11.2 Preparing and Inserting a Sound File

To insert sound:

1. Select Insert 2 Movies & Sounds = Sound from file .

2. Browse the computer to locate the folder in which the PowerPoint file was saved.

3. Select the sound file.

4. You will be asked whether to play the sound automatically. Select your desired option.

5. A speaker icon @g appears in your presentation. This indicates that the sound will start

playing when the presentation is viewed in Slide Show.

Note. You can also insert sound within PowerPoint by selecting Insert - Movies & Sounds -> Record
Sound.
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12. Inserting Pictures

Adding a picture is another useful technique to enhance the message on the slides in the tutorial. Pictures

may be used to illustrate steps involved in a procedure, for example, baking cookies, or to demonstrate a
skill such as measuring.

Pictures can be taken from the Clip Art gallery or they may be taken with your digital camera and saved
on a storage medium. If the pictures to eb used for your tutorial originate from outside of PowerPoint (e.g.

taken by a digital camera or downloaded from a website), save these pictures to the same folder as the
PowerPoint tutorial.

rPoint - [Simple machines.ppt] To insert a picture:

w | nsert | Format  Tools  Side Show  Window  Help 1. Go to the slide in your tutorial that
i |2 WewSide Culw ¥ i O you want your picture to appear.
Duplicate sid = . . _
— 53 = A s 2. Select Insert = Picture >

From File . See Figure 15.

Slides from Files...
Picture V| 8 gpart.. 3. Locate the folder that contains the

Movies and Sounds ~ » | From File... picture_

é From Scanner or Camera...

4. Open the folder.

New Photo Album... ]
- SR 5. Select the picture.
=4z Organization Chart )
@& AutoShapes 6. Click Insert.

neined Flane 4l wordart... 7. Resize the picture and position it
. at a suitable place on the slide.

Figure 15

TASK 3 Inserting sound and pictures

A. For your PowerPoint tutorial, using the sound recorder, record a welcome message for the learners of
your tutorial. Save the sound file as Welcome in your tutorial folder, Go to the Welcome/Introduction
slide and insert the Welcome sound file.

B. Insert pictures on suitable slides in the tutorial. The pictures should serve to enhance the concepts,
procedures and skills presented in the tutorial.
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13 Animating Objects

Objects in your presentation may be activated by adding animation features. However, animation must be
used sparingly and effectively.

13.1 Animating Objects - Custom Animation

To animate using Custom Animation
1. Go to the slide with the object to be animated and select the object, which can be a text box or
picture.

2. Select Slide Show - Custom Animation . The Custom Animation task pane appears (see Figure
16).

bwerPoint - [Types of Teeth3.ppt] E@E
View Insert Format Tools SlideShow Window Help =5tion f 2 - X
5 SRV $BRY o- [T HmmReE MV e - B,
A - [ Desgn EInewSide | Custom Animation
~* 4 ¢ Custom Animation Task Pane
* of ¥, [ |5 AddEffect »| | %
R %, = - =
[SEEE Incisors [ Ewence b5k 1 sincs
%5 Emphasis v |3 2 Box
Introduction Canines Incisors Premolars wE Bt E 3. Checkerboard

% Motion Paths  » 4. Circle
This type of teeth can be found af the front of the mout

Incisors are used for biting of f pieces of food. There aré

4% Object Actions » | 3% 5. Diamond
I *
_‘«*

eight incisors in our mouths. &. Dissolve In E‘
o =]
7’ 7. FlyIn
8. Wedge
o =]
More Effects...
o =]

[e4 w2 ] «

: g E slide show

Click to add notes = ¥ AutoPreview

Figure 16

3. To animate the object, select an effect from the Add Effect drop-down menu. For example, you can
animate the tooth in Figure 16 by selecting Entrance > Circle.

4. You will see a preview of the animation if the AutoPreview check box is active.
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13.2 Changing Animation Order
To change the order of an animation, select the item in the list that you want to reorder and move and
drag it to another position in the list or reorder the items using the up/down arrows below the Custom

Animation list (see Figure 17).

= 4 ¥ custom Animation v X

| |Z$} Add Effect " |K3; Remove

Modify: Blinds
Simple machines :
Start: -8 on click -
Direction: ) Speed: ) Clle arrow to
Horizontal = | |[veryFast > select a Start
1 oiserr option

2‘% Sk Tite 1: Simple m.~E

Custom Animation
List

‘ Click to add subtitle

El Re-Order | &

¥ AutoPreview

auit

Grade Four

T leam e

E==

Figure 17

Specifying Timing

When you animate an object, by default the animation only plays when you click the mouse. This can be
changed so that object appears automatically. For the tutorial that you are designing, start animation
automatically by selecting the options With Previous or After Previous in the Start drop-down menu
(Figure 17).

14. Slide Transitions

Slide Transitions allow you to select how slides will appear. Like animation effects, use slide transitions
sparingly. To add slide transition:
1. Go to the slide you wish to have a special transition effect.
2. Select Slide Show - Slide Transition .
3. On the Slide Transition task pane (Figure 18), you can:
» select the type of transition e.g. blinds horizontal or blinds vertical
* modify the transition’s speed (slow, medium, fast) and add sound

» indicate whether you want the slide to advance on mouse click or automatically.
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4. Note: Because you are designing a tutorial with action buttons such as next, previous, you do not
need to select Advance on mouse click or Advance slide automatical ly. The learner will use the
action buttons you placed in the tutorial to navigate through the presentation (e.g. next, previous
action buttons).

5. Select Play or go to Slide Show to view your animation.

[ Microsoft PowerPoint - [Simple machines.ppt]

Arial -1 ~ B J U 8 E = A A &v (2 Design = New Slide
DEdErn &Y 5= - i O BA [E A 4 W 7% 2| @)=
File Edit Wew Insert Format Tools Slide'Show Window Help reorder . X
A FEa B AR R
2| 4 + slide Transition > X
%\' e Apply to selected slides:
’2""% n\\"? Bl o Trositon -
Simple machines Blinds Horizontal j
Blinds Vertical -
Modify transition
Speed: |Fast A
Sound: |[Mo Sound] -
4 - :

Advance slide
¥ Onmouse dick
[~ Automaticaly after

‘ Click to add suhtitle _——
auT | -
et i -
,L W AutoPreview
Figure 18

Tip: It is best to maintain consistent animation effects across all slides. To ensure the same animation
effect consistent across slides, select Apply to All Slides . This will apply the effect to all slides.

Remember to use animation sparingly.

TASK 4 Animation

A. Using the Custom Animation

® Examine all your slides and select one slide for which the content would be greatly enhanced
if an object were animated. Select the object and apply a suitable animation effect.
(ii) Select three slides for which a slide transition would be suitable. Apply the transitions.
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15 Creating Assessment Tasks — Part 1

One benefit of PowerPoint is its ability to create assessment tasks with options and feedback to options

selected. Examples of assessment tasks include Multiple Choice items and True/False items.

15.1 Creating a simple multiple choice quiz

Microsoft PowerPoint - [Sample]

| Fle Ed Wew Insert Fgrmat Took SideShow Window Help Acrobst

|Tmeshewromn - 24 -|B 7 U s [EEE| A& - o Ky comentess - |
DEEH2&8y o o-- apO@a Fun ™ - @,
ma

LESSON 1 Question 1

In the science laboratory, volume of liquids
is measured using a:

1. thermometer
2. balance

3. measuring cylinder

E=0E

Ty O | Ageso- \ \COOEMAE|d-L-A-==EE@.
I Side30F7 T Defaul Design "3 J
Figure 19

[ 2 | commontasis- |

A 5
CHOWO U - 0.

D=d
i h]

LESSON 1 Question 1

In the science laboratory, volume of liquids
is measured using a:

_ thermometer

. balance

_ measuring cylinder

E=0=

| agoshapes- N N\OOE M@ - L-A-==E@@F-

| orew - fk
[ Slide 3 of 7 [ Defaul Design o
Figure 20

Figure 19 shows an example of multiple-choice

item. To prepare an item similar to the one in

Figure 19:

1. Insert a new slide at the end of a lesson,
with Title and Text layout.

2. Type your question and options.

3. Use an AutoShape or Action button to
cover each question number (see Figure
20).

4. Select each button and right click to add
text: A,Band C

You will hyperlink these buttons later to
feedback slides, which are discussed under the

topic “Creating Feedback Slides”.
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15. 2 Creating Feedback Slides

The purpose of a Feedback Slide is to provide a response to the learner which indicates that option
selected is incorrect or correct. If the option selected is incorrect, then the response on the feedback slide
should explain to the learner why the option is incorrect. If the learner selected the correct option, then the

response may have a congratulatory comment and direct her to the next question.

Les=on 1 A ezzo0n 1

d=wenl) Sorry, A is not correct. == 1) \lery Good! C is correct. [V]
The thermometer is used to The measuring cylinder is used to
measure the temperature of measure the volume of
liquids. liquids.
Point and click the curved arrow Point and click on the next button
below to try again. below to go to question 2.

u u >
Figure 21 Figure 22

You may have noticed, in Figures 21-22, that certain buttons that you placed on the Master Slide are not
visible (e.g. lesson buttons, previous). These buttons have been covered with an AutoShape to prevent
the user from being tempted to navigate easily to other sections in the tutorial.

To cover or hide buttons or objects:

1. Select and draw an AutoShape over the button or object.

2. Select the AutoShape and right-click to access Format AutoShape dialog box.

3. Format the shape by filling with colour white, and by applying white colour to the line.

TASK 5 Creating a Quiz

For each lesson , create one multiple-choice item with feedback slides for each option. Use the steps
described in Section 15 to help you.
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16. Preparing the feedback slide for the QUIT butto n

When developing interactive material, it is best to allow the learner the option of stopping or quitting the
tutorial. However, just in case, the learner clicks on the QUIT button in error, the QUIT button should
direct the learner to another slide that gives him the option to end the tutorial (Figure 23). The YES button
should have an Action Setting that hyperlinks to End Show and the NO button should have an Action
setting that links to the Last Slide Viewed .

How to design the slide in Figure 23?

1. Locate the slide entitled “Are you sure you

Are you sure you want to quit?

want to quit?”
2. On this slide, draw one action button and
hyperlink it to End Show . Add the text “YES”

to this action button.

[2]

3. Onthe same slide, copy and paste the YES
action button.

Figure 23 4. Position it next to the first button as shown in

Figure 23.

Add text “NO”.

Select the NO action button.

On the menu bar, select Insert > Hyperlink. In

the dialog box, change the hyperlink settings

to Last Slide Viewed and click OK.

TASK 6 Preparing the feedback slide for the QUIT bu  tton

Prepare the feedback slide for the QUIT button by following the instructions under the heading.
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17. Setting up the Show

Action buttons will not be very effective if the user is able to proceed to each slide on the click of a mouse.

T PR To disable this feature:
Sron o Shon s 1. Select SlideShow - Set Up Show . A dialog box
Presented by a speaker (full screen) = Al
" Browsed by an individual (window) rom: = To: =
o L e | appears.
% Browsed at a kiosk (full screen) ,—_|

2. Under Show Type , select Browsed at a kiosk

Show options Advance slides

= « Manualy (full screen) .

[~ Show without narration % Using timings, if present
I™ Show without animation Multiple monitors

Please note that by selecting this option, learners

I Show presenter View are only able to navigate using the hyperlinks you
Performance .
F . created on the Master slide, for example, the Next
Slide show resolution: [[Use Current Resolutior] | and Previous action buttons.
Cancel
Figure 24

18. Saving as a PowerPoint Show

To make your interactive PowerPoint presentation easier for students to use, you can save it as a
PowerPoint show. This creates a .pps file. When the .pps file is opened, instead of the learner viewing
the PowerPoint presentation and then selecting Slide Show, she is taken directly to the show.

To save your Presentation as a PowerPoint Show:

1. Ensure that you have saved your presentation.

2. Select File in the menu bar and choose Save As

3. Inthe Save As Type box at the bottom of the dialog box, choose PowerPoint Show

4. Inthe Save in dialog box, select the folder, which already contains the PowerPoint presentation.

5. Click on Save

To view the PowerPoint show:

1. Exit from PowerPoint by selecting File - Exit

2. Locate your folder with the PowerPoint Show and double-click on it.

3. Use your actions buttons as you did in the regular PowerPoint presentation

To end the show prematurely, press the Esc key on your keyboard.

TASK 7 Setting up the show and saving as a PowerPoi  nt show

After checking to ensure that the PowerPoint tutorial reflects all activities outlined in the Tasks 1-6, set up

the show to be browsed at a kiosk and save the presentation as a PowerPoint show.
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